
© FIRST 2012 FRC Getting Started with the 2012 FRC Control System Page 1 of 46 
 

 
 
 

Getting Started with the 2012 FRC Control 
System 

Getting Started with the 2012 FRC Control System ................................................................................................................ 2 

How to Set Up Your 2012 Driver Station ................................................................................................................................ 8 

How to Set Up Your Robot Control System .......................................................................................................................... 10 

How to Configure Your CompactRIO .................................................................................................................................... 16 

How to Build and Load Programming in LabVIEW, C/C++, and Java .................................................................................... 20 

Basic Operator Control.......................................................................................................................................................... 25 

How to Configure Your Camera ............................................................................................................................................ 27 

How to Configure Your Wireless Bridge................................................................................................................................ 29 

How to Configure Your I/O Module ...................................................................................................................................... 39 

How to Configure your Kinect ............................................................................................................................................... 43 

 

  



© FIRST 2012 FRC Getting Started with the 2012 FRC Control System Page 2 of 46 
 

Getting Started with the 2012 FRC Control System 
Welcome to the 2012 FRC season!  We strongly suggest teams complete the steps below to perform an out of the box 

(OTB) benchtop test before using any of the components to build a robot.  The OTB Test is a way to 

 determine your Driver Station system is functional at a basic level 

 assure that devices weren’t damaged in shipping 

 ensure the Classmate and cRIO are imaged correctly 

 verify Classmate operation with the Robot Controller. 

If you have feedback on the system or this document please post your comments on the FIRST Control System Forum at 

http://forums.usfirst.org/forumdisplay.php?f=23 

Acquire Needed Documentation 
You will need the following documents as you assemble your control system. Before you even open the Kit of Parts, we 

suggest you save all of these documents so they are ready for immediate reference by your team.  These documents can 

all be found on the FRC Kit of Parts Website (http://www.usfirst.org/frc/kitofparts). 

 Getting Started with the 2012 FRC Control System (this document) 

 FRC Control System Control System Component Datasheets (Power Distribution Board, Digital Sidecar, Analog 

Breakout, Solenoid Breakout) 

 2012 Kickoff Kit Checklist 

 2012 Robot Power Distribution Diagram  

 2012 Robot Data Connectivity Diagram  

Identify and Inventory Control System Components 
Identify each of the components in your kit using the descriptions and photos provided in the Kickoff Kit Checklist. 

Record the quantities you received on your printed checklist. Report any inconsistencies within 3 days of receiving your 

kit to TIMS as directed in the 2012 Competition Manual. 

Veteran teams will need to gather the following items from the 2009, 2010 or 2011 Kit of Parts: 

 cRIO 

 joysticks 

 robot wireless bridge 

 solenoid breakout 

 1 Wago power connectors 

 1 Spike relay 

Install Software on the Computer You Choose to Use for Development 
 

Note: If you are using the Classmate as your development machine, you should skip these steps and go to “How to Set 
Up Your 2012 Classmate” before completing these steps. 

 

The 2012 FRC Control System can be programmed in LabVIEW, Java or C/C++. Teams should choose their programming 

language at this point. The Classmate is a likely candidate for your Driver Station hardware, but you are also invited to 

http://forums.usfirst.org/forumdisplay.php?f=23
http://www.usfirst.org/frc/kitofparts


© FIRST 2012 FRC Getting Started with the 2012 FRC Control System Page 3 of 46 
 

use it for development, if that’s appropriate for your team. Teams may choose National Instruments LabVIEW, which 

supports a graphical programming language; Wind River Workbench, which supports C and C++ languages; or Net-Beans 

which supports Java. After compiling, executables are transferred to the cRIO. 

Regardless of the programming language you plan to use, you must install the FRC Tools from the National Instruments 

USB included in the 2012 Kit of Parts.  

If you would like to use LabVIEW, you can install it from the same National Instruments USB.  

If you would like to use C/C++, you can install Wind River Workbench 3.0 from the Wind River disc included in the Kit of 

Parts.  

If you would like to use Java, you can download Netbeans 6.7 IDE from http://java.sun.com.  

After you’ve installed your programming language base software, all teams must install the language specific updates.  

- LabVIEW (http://joule.ni.com/nidu/cds/view/p/id/2261)  

- Java (http://firstforge.wpi.edu/sf/frs/do/viewSummary/projects.wpilib/frs)   

- C/C++ (http://firstforge.wpi.edu/sf/frs/do/viewSummary/projects.wpilib/frs)  

Next, all languages are required to install the Utilities update (http://joule.ni.com/nidu/cds/view/p/id/2262).  

If you plan to use the Driver Station application on your development machine, you must also install the Driver Station 

Update (http://joule.ni.com/nidu/cds/view/p/id/2263).  

Licensing 

The National Instruments LabVIEW license is active until January 15, 2013. The WindRiver license is active until January 

31, 2013. Java has no expiration date. 

The National Instruments serial number is S14X86759. 

The Wind River Workbench License Authorization Code (LAC) is pre-populated in the installer. 

Teams are permitted to install the software on as many team computers as needed, subject to the restrictions and 

license terms that accompany the applicable software, and provided that only team members or mentors use the 

software, and solely for the FRC. Rights to use LabVIEW and Workbench are governed solely by the terms of the license 

agreements that are shown during the installation of the applicable software. 

Installation Requirements 

The installation has been tested on Windows 7 operating system.  

To install, you must be logged on as an administrator or as a user with administrator privileges. You will need Internet 

access to activate the Wind River and NI Licenses. 

Requirements for the LabVIEW Programming Environment 

Installation of the “LabVIEW Package” from the FRC USB requires 3.91 GB total disk space. This package takes an average 

of 1.5 hours to install. Installation on a Vista operating system sometimes takes longer. If you currently have National 

Instruments software on your PC, it will not interfere with that installation. However it will install over another version 

of LabVIEW 2011. 

http://java.sun.com/
http://joule.ni.com/nidu/cds/view/p/id/2261
http://firstforge.wpi.edu/sf/frs/do/viewSummary/projects.wpilib/frs
http://firstforge.wpi.edu/sf/frs/do/viewSummary/projects.wpilib/frs
http://joule.ni.com/nidu/cds/view/p/id/2262
http://joule.ni.com/nidu/cds/view/p/id/2263


© FIRST 2012 FRC Getting Started with the 2012 FRC Control System Page 4 of 46 
 

Requirements for the C/C++ Programming Environment 

Installation of the “Wind River Package” from the FRC DVD requires 2.4 GB total disk space. Note that even the C/C++ 

programming environment will require installation of many portions of the NI software to support the cRIO. On a 

Windows XP platform the Wind River software takes an average of ½ hour to install. The FRC installation must be 

installed in the directory “c:\WindRiver”. A different version of Workbench on your PC can remain installed, but it must 

be in a different directory. 

Note: If you are installing WindRiver on a 64-bit machine, please read the Workbench Installation Addendum distributed 
with the Kickoff Kit, and available on the Kit of Parts website. 

 

Users of the software must read the license agreements that are shown during installation of the software carefully and 

completely. 

Requirements for the Java Programming Environment 

Installation of the “Java package” requires a minimum of 350 MB disk space and 512 RAM. Note that even the Java 

programming environment will require installation of many portions of the NI software to support the cRIO. On a 

Windows XP platform the Java software takes an average ½ hour to install. Users of the software must read the license 

agreements that are shown during installation of the software carefully and completely. 

Before Installing 

Deactivate / Uninstall software 

1. Disable any automatic virus detection programs before you install. Some virus detection programs interfere with 

installation. (NOTE: Some of the beta test teams that did not disable virus detection before installation needed 

to re-install their programming environments again to remedy problems encountered in installation.) 

2. If you have another version of the Wind River Workbench installed, make sure it is not in the C:\WindRiver 

directory because that is the preferred location for the FRC installation (some of the tools expect that location). 

Install LabVIEW 2011 and Associated Components 
1. Insert the NI LabVIEW 2011 for FRC 2012 USB. If the Autorun program doesn’t open, navigate to the USB drive 

through “My Computer” and click Autorun. 

2. If you're programming in LabVIEW, click the Install Everything link and follow the instructions that appear on the 

screen. If you're programming in C/C++ or Java, click the Install only the FRC Tools link and follow the 

instructions that appear on the screen. 

3. When prompted, enter the serial number, S14X86759, in the Serial Number text box. 

4. On the Installation Summary page, choose to Run License Manager to activate the product(s) and click the 

Next button to display the NI Activation Wizard. 

5. Select the Automatically activate through a secure Internet connection option and click the Next button. 

6. Enter the serial number, S14X86759, in the LabVIEW 2012 FIRST Robotics Competition text box. 

7. Follow the instructions that appear on the screen to complete activation. 

8. Install updates, see above. 

  

http://www.usfirst.org/frc/kitofparts
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Install Wind River Workbench 

Installation Procedure 

NOTE: If you have just installed the previous USB the National Instruments Activation Wizard may start 
while Workbench is being installed. Internet access is needed to complete the install for Workbench. 

 

Insert the DVD. After a few minutes the Installer-Welcome screen will appear. Follow instructions on your screen.  

At the Installer-Choose Activation Type screen, select Permanent activation and click Browse. 

 

Browse to the DVD-R138732.1-1 directory and select FirstRobotics_2012_install.txt file. Click Open. No internet 

connectivity is required to obtain your product activation file (FirstRobotics_2012_install.txt). 

The FirstRobotics_2012_install.txt file contains the installation keys and licensing needed to install and activate Wind 

River products. Once the path to the FirstRobotics_2012_install.txt (product activation file) is displayed under 

Permanent activation, click Next. 

At the Installer-Choose Installation Filters screen, make no changes. Click Next. Follow the instructions until the process 

is complete.   
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Installing Java and Tools 

Installation Procedure 

This is an overview on to install the Java SDK for FRC. For complete details please read the "Java Getting Started Guide" 

found in the "Documents" section of the WPILib project at 

http://firstforge.wpi.edu/sf/frs/do/viewSummary/projects.wpilib/frs.  

Required Software 

In order to setup your machine to program in Java, the following software components are required: 

• Java SE Development Kit (JDK) version 6. 

• NetBeans IDE version 6.7 or later. 

You can use other IDEs if desired but the focus for this document is NetBeans. 

• SunSPOT Java SDK for FRC which includes WPILib. 

All these components can be installed on Windows, Mac OSX, or linux. Each platform requires slightly different 

installation procedures. 

Install the Java tools in three steps, downloading the components from the Internet for each step: 

1. Install the Java SE Development Kit (JDK) version 6 available from http://java.sun.com.  

Note: Your development system may already have the JDK installed, for example on Mac OS X. 

Note: On 64-bit Windows the SunSPOT tools still need a 32-bit JDK so download a JDK for platform “Windows” 

not “Windows x64.” You can install the JDK in C:\Java\32-bit\ even if you also have a 64-bit JDK in, say, C:\Java\. 

Give this SDK location to the NetBeans installer wizard. 

2. Install NetBeans version 6.7 or later. This is available from http://netbeans.org/downloads. 

3. Add the FRC plugins to NetBeans. These plugins can be downloaded from the WPILib project on 

http://firstforge.wpi.edu/sf/projects/wpilib or installed via the NetBeans built in downloader as described in the 

following sections of this document. 

Note: The details of each step vary by operating system and browser. 

Besides the tools for Java programming you’ll also need: 

• The FRC cRIO Imaging Tool to format/initialize your cRIO for Java programming. This tool is currently only 

released and supported for Windows. 

• Optionally the FRC Driver Station software to control your robot, also only supported on Windows. 

These tools are available online as an update to the installed LabVIEW platform installer DVD that is included with the kit 

of parts. You can find these updates on the FIRST web site team updates page: 

http://usfirst.org/roboticsprograms/frc/content.aspx?id=450. 

Installing the NetBeans Plugins: Sun SPOT Java SDK for FRC and WPILib 

The FRC Plugins add the FRC specific components to your standard NetBeans installation. The NetBeans plugins contain 

everything needed to extend your Java development environment to program your cRIO. The FRC plugins enable 

NetBeans to directly download and debug code on the NI cRIO controller. The plugins include project templates and 

http://firstforge.wpi.edu/sf/frs/do/viewSummary/projects.wpilib/frs


© FIRST 2012 FRC Getting Started with the 2012 FRC Control System Page 7 of 46 
 

sample programs to help you get started developing robot programs. Please read the "Java Getting Started Guide" for 

details on how to install the plugins offline or using the online update site. 
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How to Set Up Your 2012 Driver Station 

Reimage the Classmate 
Before you use your Classmate, you must reimage your machine, regardless if you have the 2010, 2011 or 2012 model. 

To do this, please follow the steps below:  

1) Make sure the Classmate is turned off, but plugged in. 

2) Insert the “2012 Image” USB Thumb Drive into a USB port on the Classmate. (Remember use the “2012 Image 

for the E11 Classmate” for the Classmates distributed in 2011 and 2012, and the “2012 Image for the E09 

Classmate” for the Classmates distributed in 2010).  

3) Power on the Classmate and tap the F11 key on the USB keyboard. Tapping the F11 key during boot will bring up 

the boot menu.  

4) Use the arrow keys on the keyboard to select the USB device (it will be called “Generic Flash Disk”). 

5) Press the ENTER key when the USB device is highlighted.  

6) To confirm that you want to reimage the Classmate, type “1” and click ENTER. Then, type “Y” and click ENTER. 

The Classmate will load the CTL AutoInstaller.  The installation will take 15-30 minutes. 

7) When the installation is complete, remove the USB drive.  

8) Restart the Classmate. The Classmate will boot into Windows.  

Initial Driver Station Boot 
The first time the Classmate is turned on, there are some unique steps, listed below, that you’ll need to take. The initial 

boot may take several minutes; make sure you do not cycle power during the process. 

Please note that these steps are only required during original startup. 

Initial Driver Station Set Up 

1. Log into the Developer account. 

2. Click “Ask me later”. 

3. Click “OK”. The computer now enters a Set Up that may take a few minutes. 

4. Establish an Internet connection. 

5. Once you have an Internet connection, click the Start menu, right click “Computer” and click “Properties”. 

6. Scroll to the bottom section, “Windows activation”, and Click “Activate Windows now” 

7. Click “Activate Windows online now”. The activation may take a few minutes. 

8. When the activation is complete, close all of the windows. 

9. Navigate through the Microsoft Security Essentials Setup Wizard. Once it is complete, close all of the windows. 

10. Set a theme for your computer by right clicking anywhere on the Desktop and clicking “Personalize”. 

11. Scroll within the themes and select a theme. We recommend “Windows 7 Basic”. Note that using any of the 

“Aero” themes has been shown to slow down processing when using the Microsoft Kinect.  

Update Classmate Software 

In order for the Classmates to arrive at Kickoff locations in time, they were shipped before the final version of the 

software was ready. It is essential that you update your classmate software before proceeding so that you are using the 

most updated software throughout this set up and during competition. 

a) Retrieve the driver station update http://joule.ni.com/nidu/cds/view/p/id/2263.   

 

b) Open file 

http://joule.ni.com/nidu/cds/view/p/id/2263
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c) Click setup.exe 

d) Choose next 

e) Choose next 

f) Product notifications are optional. Answer as you see fit. 

g) Read, and if appropriate, accept the user license agreement. (If you do not accept the user license agreement, 

I’m afraid we’re in trouble…) 

h) Ditto for the supplemental license agreement 

i) After the software loads, choose finish and restart the computer when prompted 

Set your team number 

When the classmate reboots it will automatically open the Driver account. 

Click on the Set up Tab and enter your team number in the field provided and Tab out of the field. As noted above, 

we’ve used team number 9999 for these examples. 

 

  



© FIRST 2012 FRC Getting Started with the 2012 FRC Control System Page 10 of 46 
 

How to Set Up Your Robot Control System 
Veteran teams may skip this step and use their robot from a prior season in place of the bench top set up when testing 

the Driver Station set up throughout the rest of this document. 

Locate the following control system components and layout their locations on an appropriate nonconductive surface 

(e.g. plywood or plastic) to permit wiring connections as shown in the power distribution diagram on the FRC Kit of Parts 

Website. Plan the positions of the components to leave space to access the various connectors. 

• Kit Materials: 

o Power Distribution Board 

o cRIO with modules (1x NI9201 in slot 1; 1x NI 9403 in slot 2; 1x NI 9472 in slot 3) 

o Analog Breakout (to be installed with the NI 9201 module in slot 1) 

o Digital Sidecar (to be connected to the NI 9403 module in slot 2) 

o Solenoid Breakout (to be installed with the NI 9472 module in slot 3) 

o Wireless bridge, DAP-1522 

o Circuit breakers 

o Jaguar speed controllers, qty 2 (Team-provided Victor 884 speed controllers may also be used) 

o 2 PWM cables 

o Crossover cable 

o 120-amp circuit breaker (CB3-SM-120 or similar) 

o 12V DC motors, qty 2 

o 6 AWG wire and ring terminal connectors 

o 22 AWG or better wire 

o 18 AWG or better wire 

o Appropriate wire and connectors for size of motors 

o 12V Battery (Enersys NP18-12 recommended) 

o 12V/5V Adapter 

• Tools Required: 

o Wago Tool 

o M6 nut driver (10mm socket) 

o Jeweler’s flat-head screwdriver 

o Wire cutters, strippers, and crimpers 

o 7/16” nut driver 

An example of a completed bench top setup is shown in Figure 1. 
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Completed Robot Control System Benchtop Set Up 

Control System Set Up 

Power Distribution Board (PD) 

Make each of the following connections. Refer to the Power Distribution Board datasheet located on the Kit of Parts 

website for additional detailed information. 

 

Power Distribution Board Connections 

• 12V Power connection to the Power Distribution Board from the 120-Amp circuit Breaker 

o WARNING: the shanks on the Power Distribution Board use metric M6 nuts. Use of ¼” nuts will strip the 

studs on the Power Distribution Board. 

o NOTE: Do not connect a battery to the Power Distribution Board until after all other connections are 

established and double-checked. 

• 24V Power connection to the cRIO 

• Power connections to the Analog Breakout, Digital Sidecar, and Solenoid Breakout from the VB3 breaker outputs 

(use 20A breaker).  

• Power connection to the Jaguar Speed Controllers from any of the Maxi Breaker outputs (for 40A circuits). 

http://www.usfirst.org/frc/kitofparts
http://www.usfirst.org/frc/kitofparts
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cRIO 

Make each of the following connections. Refer to the cRIO manual link available in section 3.2 for additional detailed 

information. 

 cRIO-FRC II cRIO-FRC 

Slot 1 9201 (with Analog Breakout) 9201 (with Analog Breakout) 

Slot 2 9403 (connected to Digital Sidecar) 9403 (connected to Digital Sidecar) 

Slot 3 9472 (connected to Solenoid Breakout) 9472 (connected to Solenoid Breakout) 

Slot 4 Empty Either 9201, 9403, or 9472 as needed 

Slot 5 9201 (with Analog Breakout) N/A 

Slot 6 9403 (connected to Digital Sidecar) N/A 

Slot 7 9472 (connected to Solenoid Breakout) N/A 

Slot 8 Empty N/A 

Connect the 24V cRIO supply from the PD board using the supplied power connector (Part NO CTF040V8). Plug the 

Ethernet cable from network port 1 to the Driver Station. 

 

cRIO 24V Power Connection 

Analog Breakout 

Make each of the following connections. Refer to the Analog Breakout datasheet in for additional detailed information. 

• Plug the Analog Breakout to the NI 9201 module installed in slot 1 of the cRIO 

• Connect J3 to the Power Distribution Board using a 20A Circuit 

• Install a jumper on the Analog Breakout’s “Battery Selection Jumper” in accordance with the Analog Breakout 

Datasheet to enable battery monitoring. 

Solenoid Breakout 

Make each of the following connections. Refer to the Solenoid Breakout datasheet in section 3.5 for additional detailed 

information. 

• Plug the Solenoid Breakout into the NI 9472 module installed in slot 3 of the cRIO. 

• Connect J3 to the Power Distribution Board using a 20A Circuit 
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Analog & Solenoid Breakout Power Connections 

Digital Sidecar 

Make each of the following connections. Refer to the Digital Sidecar datasheet for additional detailed information. 

• Using the supplied DB-37 ribbon cable, connect to the NI 9403 module installed in slot 2 of the cRIO.  

• Connect J22 to the Power Distribution Board using a 20A Circuit 

Connect PWM cables to Jaguar Speed Controllers (PWM #1 to Jaguar #1; PWM #2 to Jaguar #2). 

 

Digital Sidecar Connections 

120-Amp Circuit Breaker 

Make each of the following connections. 

• Connect the “BAT” terminal to the “+” terminal of an Anderson connector 

• Connect the “AUX” terminal to the “+” terminal on the PD board. 
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120 Amp Breaker Setup 

Jaguar Speed Controllers and 12VDC Motors 

Make each of the following connections for each of the two Jaguar speed controllers and associated 12VDC motors. 

Refer to the parts datasheet for additional information 

• Connect the “V-” terminal to the “-” output of either a Maxi or VB3 breaker on the PD board 

• Connect the “V+” terminal to the “+” output of the same Maxi or VB3 breaker on the PD board 

• Connect the “M-“ terminal to one of the motor input leads 

• Connect the “M+” terminal to the other motor input lead of the same motor 

NOTE: Do not connect the Ethernet cable between the bridge and the cRIO at this time. The first 
benchtop test will utilize “tethered” operation. Only after completion of the test with tethered 
operation will the bridge be used for a wireless connection to the Driver Station. 
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Jaguar Power Connections 

At this point, your electrical wiring for the “robot” portion of the benchtop test should be complete. Before turning the 

benchtop system on, ensure that all power connections are connected with the proper polarity and that any power 

cables you manufactured are correct. Applying reversed power will permanently damage many of the control system 

components (e.g. the wireless adapters and Jaguar speed controllers).  

Confirmation of LED Status on Control System Components  
Before powering on either your robot or your “bench top” system, ensure the motors are located in such a way that if 

they were to become immediately operational, they would not pose a safety hazard. Also ensure the joysticks plugged 

into the Driver Station are ‘centered’.  

1. Connect a battery to the Anderson connector of the “benchtop test” setup. Turn on the power to the “benchtop 

test” setup at the Hi-Amp 120A circuit breaker.  

2. Immediately after turning on the power, confirm that each of the items below is operating correctly: a. On the 

Power Distribution Board, three green LEDs should be lit: +5V supply, +24V supply, and +12V supply  

a) On the Digital Sidecar, three green LEDs should be lit: “Power Input,” +5V, and +6V  

b) On the Analog Breakout, one green LED should be lit.  

c) On the Solenoid Breakout, one green LED should be lit  

d) The Jaguar LEDs should be flashing yellow.  

e) Note that the Driver Station display will provide status on communications with cRIO, code running state, 

etc. 
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How to Configure Your CompactRIO 
All FRC teams, both Rookie and Veteran teams, must configure/reconfigure the cRIO in preparation for the 2012 season. 

The cRIO Imaging Tool is preloaded on the Classmate and is also available on the Software included in the Kit of Parts. 

Set the Static IP Address of the Computer you are using for development 

Note:  This is for Windows 7.  The steps for Windows XP will look slightly different. 

 

1. Select Start»Control Panel» View Network Status and Tasks»Change Adpater Settings»Local Area Connection to 

display the Local Area Connection Properties dialog box. 

2. On the General page, select Internet Protocol (TCP/IPv4) 

3. Click the Properties button to display the Internet Protocol (TCP/IP) Properties dialog box. 

4. Select the Use the following IP address option. 

5. In the IP address text box, if this computer is the Classmate and you have run the Driver Station software and 

successfully set your team number, you should see 10.xx.yy.5, where xx corresponds to the first one or two 

digits of your team number and yy corresponds to the last two digits of your team number. If this is not the 

classmate PC you should set the address to 10.xx.yy.6 as the Driver Station defaults to 10.xx.yy.5 for its IP 

address. In this text box, change the final digit .5 to .6. 

Team Number Static IP Address 

45 10.0.45.6 

234 10.2.34.6 

1024 10.10.24.6 

6. The Subnet mask text box defaults to 255.0.0.0. Change this value to 255.255.255.0 

7. Click the OK button twice to close the Internet Protocol (TCP/IP) Properties and Local Area Connection 

Properties dialog boxes. 

8. Click the Close button to close the Network Connections dialog box. 

Considerations Before Running the cRIO Imaging Tool 
Before configuring the cRIO with the cRIO Imaging Tool, you must ensure that the hardware and software are configured 

properly. You should also ensure you have all of the latest updates, including the latest Utilities update. 

Do not use the cRIO Imaging Tool on the cRIO over a wireless connection. If the connection is lost, the data that the cRIO 

Imaging Tool writes to the cRIO will be corrupted. 

Do not use Measurement and Automation Explorer (MAX) to install additional software on the cRIO. MAX overwrites the 

FRC VIs on the cRIO, which makes the cRIO unusable for the FRC competition. If you use MAX to install additional 

software on the cRIO, you must use the cRIO Imaging Tool to restore the device to a usable state. 

Before running the cRIO Imaging Tool, ensure the SAFE MODE switch on the cRIO is turned off (this only applies to the 

cRIO-FRC, on the cRIO-FRC II, the dipswitches are only available on the cRIO Imaging Tool). For routine use, do not use 

the cRIO Imaging Tool when the cRIO is in SAFE MODE. 
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Severe corruptions of the software or settings on the cRIO result in the device no longer functioning. If the cRIO is 

corrupted or if the IP Address is set incorrectly, the device boots only in SAFE MODE. When this occurs, switch the device 

into SAFE MODE. The cRIO Imaging Tool offers to reformat the disk. After the disk has been reformatted, switch the cRIO 

out of SAFE MODE, reboot, and run the cRIO Imaging Tool normally. 

Running the cRIO Imaging Tool 
Complete the following steps to configure the cRIO with the cRIO Imaging Tool.  

Note: Make sure the wireless is turned off on your computer before doing these tasks. 

 

1) Plug the cRIO into the Classmate using the yellow Ethernet crossover cable provided in the Kit of Parts. 

2) Select Start»All Programs»National Instruments(folder)»LabVIEW 2011(folder)»FRC 2012 cRIO Imaging Tool to 

launch the cRIO Imaging Tool dialog box. You also can display this dialog box by selecting Utilities»cRIO Imaging 

Tool in the LabVIEW Getting Started window. 

3) Select the cRIO you want to configure from the Select cRIO Device table. This table lists all cRIO devices visible 

on the network to the host computer. 

4) In the Development Environment section, specify whether you want to run and debug LabVIEW, C/C++, or Java . 

a. When developing robot code using LabVIEW it is recommended that the ”Always run deployed code at 

startup” option be selected, but means that using the Undeploy option in LabVIEW will do nothing. 

5) Place a checkmark in the Format Controller checkbox. Use the Format Controller section to restore an image on 

the cRIO or update the cRIO with a new name or team ID. 

6) From the Select Image list, select the most recent FRC_2012_xx.zip file to download the FRC_2012_xx image to 

the cRIO. The FRC_2012_xx image consists of support for LabVIEW, C/C++, and Java programming and supports 

both the cRIO-FRC and the cRIO-FRC II. 

7) Enter the name you want to use to identify the cRIO in the Device name text box. 
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8) Enter your team number in the Team ID field. The cRIO Imaging Tool sets the IP address of the cRIO to 

10.xx.yy.2, where xx corresponds to the first or first two digits of the team number and yy corresponds to the 

last two digits of the team number. 

9) Click the Apply button to apply the changes you made and download the FRC_2012_xx image to the cRIO. Do 

not turn off power to the cRIO or interfere with the network connection while the cRIO Imaging Tool downloads 

the image to the cRIO. 

10) When the reconfiguring device window states the CompactRIO image was successfully updated, click close on 

the small dialog box. 

11) Allow the tool to rescan and detect your cRIO. The cRIO graphic should now show green for all modules which 

are installed in the correct locations. Any red modules are either missing or not installed in the correct slot, 

hover your mouse over the red module graphic for more information. Click “Rescan” if you would like to update 

the graphic. 

12) After verifying that all modules are installed in the proper locations, close the cRIO Imaging Tool. 

 

If you want to switch to another development environment, select the new development environment from the Choose 

Development Environment section and click the Apply button. Switching development environments does not reformat 

or download a new image to the cRIO. 

Refer to the LabVIEW Robotics Programming Guide for the FIRST Robotics Competition for more information about the 

cRIO and other programming procedures. You can access this guide by selecting the Tutorials tab on the LabVIEW 

Getting Started window, by navigating to the Progam Files\National Instruments\LabVIEW 2011\manuals\FRC 

Programming Guide directory and opening index.html or by browsing to http://www.ni.com/info and entering 

“FRCTutorials” for the Info Code. 

Using the Classmate with your cRIO 
1) Log into the Driver Account 

2) Plug the following devices into your Classmate 

- Joysticks 

- cRIO using the yellow crossover Ethernet cable (via the only Ethernet port on the Classmate and port 1 on 

the cRIO) 

 

The basic Driver Station setup with simulated robot (cRIO, motors, etc) 

3) Turn on your cRIO using the 120A main circuit breaker (make sure that the Analog Breakout Board is attached to 

the 9201 module in slot 1 of your cRIO and that it has the jumper installed for battery voltage tracking). 

The cRIO should have a 9201 module in slot 1 with the accompanying Analog Breakout board installed and wired 

http://www.ni.com/info
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4) On the left side of the Driver Station window, check the status indicators to confirm that the Classmate has 

communication with the cRIO (meaning that IP addresses are set and the cRIO has been imaged). This will be 

indicated with a green light next to Communications.  

Screenshot 1 

Status indicators relay crucial information about system performance. 

5) In the Setup Tab, confirm that the Driver Station recognizes your joysticks. Joysticks should be listed in green. If 

the joysticks were not connected or recognized hit F1 to cause the DS to re-enumerate the USB joystick devices. 
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How to Build and Load Programming in LabVIEW, C/C++, and Java 
Teams should only read the section for the programming language they have chosen. 

How to Build and Load a LabVIEW Program 

Configuring an FRC Robot Project 

1) Launch LabVIEW. 

2) Click the FRC cRIO Robot Project link in the Projects window to display the Create New FRC Robot Project dialog 

box. 

3) In the Project name text box, enter the name you want to use to identify the new FRC robot project. 

4) In the Project folder text box, enter the location on the host machine to which you want to save the project files 

and VIs. 

5) In the cRIO IP address text box, enter the IP address of the cRIO to which you want to deploy the project. The IP 

address of the cRIO must be in the form 10.xx.yy.2, where yy corresponds to the last two digits of the team 

number and xx corresponds to the remaining first or first two digits of the team number. Note that the team 

number entered here should not contain any leading zeroes.  

Team Number cRIO IP Address 

45 10.0.45.2 

234 10.2.34.2 

1107 10.11.7.2 

 

6) Click the Finish button to close the Create New FRC Robot Project dialog box and create the new FRC robot 

project. LabVIEW displays the new FRC robot project in the Project Explorer window. 

Running the FRC Robot Project 

You can deploy the FRC robot project to the cRIO before making any modifications. In the Project Explorer window, 

right-click the Robot Main.vi item and select Run from the shortcut menu. LabVIEW deploys the Robot Main VI and any 

support files for the VI to the cRIO. The Robot Main VI then runs on the cRIO. If the robot has a joystick connected to 

port 1 of the Driver Station and Jaguar motor controllers controlling the two wheels, you can move the joysticks and 

observe how the robot responds. 

You also can run the FRC robot project on the cRIO and maintain a connection with the host computer to perform live 

front panel programming and debugging. By maintaining a connection with the host computer, you can monitor 

indicators and observe how changes to the front panel of VIs affect the behavior of the robot. 

Complete the following steps to run the FRC robot project and perform live front panel debugging. 

1) In the Project Explorer window, double-click the Robot Main.vi item to open the Robot Main VI. 

2) Click the Run button of the Robot Main VI to deploy the VI to the cRIO. LabVIEW deploys the VI, all items 

required by the VI, and the target settings to memory on the cRIO. 

3) Move the joysticks and observe how the robot responds. 

4) Click the Abort button of the Robot Main VI. Notice that the VI stops. When you deploy a program with the Run 

button, the program runs on the cRIO, but you can manipulate the front panel objects of the program from the 

host computer. 
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If you redeploy the Robot Main VI with the Run button, the cRIO stops and restarts the Robot Main VI. LabVIEW 

redeploys any VIs that changed or are no longer in memory on the cRIO. 

Refer to the LabVIEW Robotics Programming Guide for the FIRST Robotics Competition for more information about 

creating and running a LabVIEW program. You can access this guide by selecting the Tutorials tab on the LabVIEW 

Getting Started window, by navigating to the Program Files\National Instruments\LabVIEW 2011\manuals\FRC 

Programming Guide directory and opening index.html or by browsing to http://www.ni.com/info and entering 

“FRCTutorials” for the Info Code. 

How to build and load a C/C++ program 

Creating the sample program 

1) Launch WindRiver Workbench using the desktop shortcut. 

2) Select “New” then “Example…” from the File menu. 

3) Choose “VxWorks Downloadable Kernel Module Sample Project” and click “Next>”. 

 

4) Choose “Default Robot Main Program” from the list of choices presented and then click “Finish”. 

http://www.ni.com/info
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5) Notice that the project is now loaded into the Project Explorer tab on the left panel of Workbench. 

 

6) If you double-click on the “DefaultRobot.cpp” file name in the Project Explorer, you’ll see the C++ source code in 

a tab in the main window in Workbench. 
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7) To build the program, right-click on the project name in the project explorer and select “Build Project” from the 

pop-up context menu. 

 

8) You should see the results of the build in the “Build Console” tab at the bottom of the Workbench window. If 

you don’t see these results, exit from Workbench and restart it, then rebuild the project. 

 

Downloading the program 

1) Set up your team number in Workbench so it can find your robot. To do this, select “Window” and then 

“Preferences” from the main menu. 

2) On the preferences window select “FIRST downloader preferences”. Then fill in your team number and the file 

to download to the robot. It will likely be: 

C:\WindRiver\workspace\DefaultRobot\PPC603gnu\DefaultRobot\Debug\DefaultRobot.out You can use the 

“Browse…” button to find it.  

Once done these settings don’t need to be changed until you decide to work on a different project. 

3) To download the program click on “FIRST” and then “Deploy” from the Main menu in Workbench. If the cRIO is 

properly set up, the file will be downloaded. 

Running the program 

Reboot the cRIO to run the program and then proceed to “Basic Operator Control to verify basic teleoperated and 

autonomous control of the robot. The steps here are described in more detail in the C/C++ Getting Started Guide 

available in: C:\WindRiver\docs\extensions\FRC\GettingStartedWithC or at http://firstforge.wpi.edu/sf/go/doc1197.  

How to build and load a Java program 

Creating the BuiltInDefaultCode Project 

1) Launch NetBeans. 

http://firstforge.wpi.edu/sf/go/doc1197
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2) Select “File > New Project…”. 

3) In the New Project Dialog, browse to “Samples > FRC Java”. 

4) Select “DefaultCodeProject” 

5) Click “Next >” 

6) Click “Finish” 

NetBeans displays the new BuiltInDefaultCode project in the Projects window. 

Building and Running the BuiltInDefaultCode Project 

You can build and deploy the BuiltInDefaultCode project to the cRIO before making any modifications. Before starting 

insure that the computer you’re using for software development is connected and configured with the correct IP 

address as instructed in Section 2.6. If you are using the Classmate Driver Station for software development, the IP 

address should already be correctly set. If you are use another computer for software development, its IP address 

should be set to an address that doesn’t conflict with the Classmate, robot or wireless bridge, such as 10.xx.yy.6 or 

10.xx.yy.10 (where xxyy is your team number). Complete the following steps to build and run the default code: 

1) Right-Click on the BuiltInDefaultCode project name. 

2) Select “Set as Main Project” from the pop-up menu. 

3) Click the green “Run Main Project” arrow in the NetBeans toolbar. 

The BuiltInDefaultCode will build, load and run on the cRIO. You can proceed to “Basic Operator Control” to verify basic 

teleoperated and autonomous control of the robot. Note that you may want to uncomment the autonomous code in 

BuiltInDefaultCode before building and testing. 
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Basic Operator Control 

Confirmation of “Tank Drive” Control System Component Operation 
Before powering on the “benchtop” system, ensure that the motors are located in such a way that if they were to 

become immediately operational, they would not pose a safety hazard. Also ensure the joysticks plugged into the Driver 

Station are ‘centered’. 

1. Move the joystick #1 Z-Wheel to the down position [-]. 

2. Power up the Classmate Driver Station and the benchtop system. 

3. Set the Classmate Driver Station to “Operation > Enable”. When enabled, the Jaguar LEDs should be solid yellow 

(assuming that the joystick inputs are centered.) 

4. The “benchtop” system is now configured so that the two joysticks should give “tank drive” behavior. For an 

“out of the box” cRIO, you should observe the following behavior: 

a. Move joystick #2 all the way forward. The Jaguar connected to PWM #1 should have its LED change 

color to green and the motor connected to that Jaguar should turn forward. 

b. Move joystick #2 all the way backward. The Jaguar connected to PWM #1 should have its LED change 

color to red and the motor connected to that Jaguar should turn in reverse. 

c. Joystick #1 full forward should result in Jaguar on PWM #2 having a red LED and the motor turning in 

reverse. 

d. Joystick #1 full backward should result in Jaguar on PWM #2 having a green LED and the motor turning 

forward. 

Confirmation of “Arcade Drive” Control System Component Operation 
1. Move the joystick #1 Z-Wheel to the up position [+]. 

2. The “benchtop” system is now configured so that joystick #1 should give “arcade drive” behavior. For an “out of 

the box” cRIO, you should observe the following behavior: 

a. Move joystick #1 all the way forward while keeping the joystick centered from right to left. The Jaguar 

connected to PWM #1 should have its LED switch to green and the motor connected to that Jaguar 

should turn forward; meanwhile, the Jaguar connected to PWM #2 should have its LED switch to red and 

the motor connected to that Jaguar should turn in reverse. 

b. Move joystick #1 all the way backward while keeping the joystick centered from right to left. The Jaguar 

connected to PWM #1 should have its LED switch to red and the motor connected to that Jaguar should 

turn backward; meanwhile, the Jaguar connected to PWM #2 should have its LED switch to green and 

the motor connected to that Jaguar should turn forward. 

c. Move the joystick to each of the four “corners” – when completely in each “corner” only one motor 

should turn. (This would implement “pivot” turns on a typical FRC robot.) 

d. While holding down button 2 of the joystick, move the joystick from side to side. Both motors should 

turn with rates proportional to the distance the joystick is moved away from center. This would 

implement “spin” turns on a typical FRC robot. 

e. Experiment with moving the joystick to different positions, noting that different output behaviors take 

effect depending upon the position of the joystick. 

3. Set the Classmate Driver Station to “Operation > Disable.” 

4. Turn off the “benchtop” system by firmly pressing the red button on the Hi-Amp 120A circuit breaker. 

5. Turn off the Driver Station by powering down the Classmate. 
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Confirmation of “Autonomous” Control System Component Operation 
Before powering on the “benchtop” system, ensure that the motors are located in such a way that if they were to 

become immediately operational, they would not pose a safety hazard. Also ensure the joysticks plugged into the Driver 

Station are ‘centered’. 

1. Turn on the Driver Station by powering up the Classmate. Wait approximately 35 seconds for the Driver Station 

to boot to the status screen. 

2. Set the Driver Station to “Mode: Autonomous” using the buttons on the Operation tab of the DS. 

3. Confirm that the screen reads “System: Disabled” and “Mode: Autonomous.” 

4. Turn on the power to the “benchtop” system and wait for the cRIO to boot. Set the Driver Station to “System: 

Enabled” using the enable toggle on the Operation tab of the DS. 

5. Set the Driver Station to “System: Disabled” in the Operations tab to disable the benchtop system. 

6. Set the Driver Station to “Mode: Teleoperated” in the Operations tab. 

7. Set the Driver Station to “System: Enabled” to re-enable the benchtop system with teleoperated control. Check 

that the motors move in accordance with the program coded for the joystick(s). 

8. Set the Driver Station to “System: Disabled.” 

9. Turn off the “benchtop” system by firmly pressing the red button on the Hi-Amp 120A breaker. 

10. Turn off the Driver Station by switching to the setup tab and hitting the exit button, then logoff and power down 

the Classmate. 
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How to Configure Your Camera 
The camera comes with a network address of 192.168.0.90 and a root password of “pass”. The IP address and user 

accounts must be updated to work for the recommended FRC configuration (camera is plugged into robot radio). 

Using the Camera Configuration Tool 
A tool to automatically configure the camera for FRC use is installed with the FRC Utilities Update. 

1. Connect your computer to the camera using a crossover Ethernet cable. 

2. Set your PC’s IP address to 192.168.0.XX where XX is something not in use (1-255), for example 192.168.0.6. See 

“How to Set Up Your 2012 Driver Station” for instructions on how to set a static IP address. 

3. Close the window and wait while it configures the network card. 

4. Select Start»All Programs»National Instruments(folder)»LabVIEW 2011»Setup Axis Camera to launch the Setup 

Axis Camera Tool dialog box. You also can display this dialog box by selecting Tools»Setup Axis Camera in 

LabVIEW. 

5. The green Indicator light next to the text “Camera found at 192.168.0.90” should be lit. If it is not, verify that 

your camera is powered on (the ring on camera face should be green) and properly connected and that your 

computer IP address was set properly in steps 2 and 3. If the indicator is still unlit, reset your camera using the 

instructions contained inside the tool as Step 3. 

6. Ensure the Robot Radio option is selected and enter your team number in the Team ID box. 

7. Click Apply. 

 

Manual Configuration of the Camera 
The username/password combinations that work with the default code are shown in the table below. As long as at least 

one of these users is configured, the camera initialization software will work. 

User name FRC 
Password FRC 
root pass (Axis default, must be changed) 
root admin 
FRC FRC 

To change passwords: 

1. Connect your computer to the camera using a crossover Ethernet cable. 

2. Set your PC’s IP address to 192.168.0.XX where XX is something not in use (1-255), for example 192.168.0.6. See 

section 5.2.1 for instructions on how to set a static IP address. 

3. Close the window and wait while it configures the network card. 

4. Navigate your web browser to http://192.168.0.90/. 

5. If a “Configure Root Password” dialog box pops up, enter the username "root" and the password "pass". 

6. If a login dialog pops up, enter the username "root" and the password "pass" (this is the default password). 

7. In the top right, click "Setup" 

8. On the left, click "Users" 

9. Click "root" and click "Modify" 

10. Enter the password “admin” into the two password boxes. 

11. Click “OK”, then “Save”. 
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To change the IP: 

1. On the left, click “TCP/IP” 

2. Click on the radio button next to “Use the following IP address” to select it 

3. In the “IP address” box enter 10.xx.yy.11. The xx.yy is the same as is used for the robot. 

4. Click “Save” 

The camera can also be connected to the second Ethernet port on the 8-slot cRIO FRC. In this configuration the IP is left 

at the default 192.168.0.90. The User name and Password are setup identically to if the camera is connected to the radio 

Camera tools and documentation 
A link for vendor information about the Axis M1011 camera can be found from the Kit of Parts website. 

 

Camera Power Feed on the Power Distribution Board 

  

http://www.usfirst.org/frc/kitofparts
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How to Configure Your Wireless Bridge 
This section describes the features and functionality of the new D-Link DAP-1522 robot wireless bridge, and the steps 

used to configure it for use on an FRC robot.  

NOTE: The screenshot examples in this document reflect an example wireless bridge configured for team 1995 

Overview of the DAP-1522 

Features 

The D-Link DAP 1522 is the robot wireless bridge for the 2012 season.  Some new features of this unit as compared to 

the 2009 and 2010 seasons include 

 Access Point mode: computers with wireless networking capabilities can connect to the DAP-1522 directly 

(without additional wireless routers or bridges).  This is the recommended operating mode when teams are 

developing their robots at home 

 Bridge mode: allows the DAP-1522 to connect to an access point.  This mode is used at FRC events to allow the 

robots on the field to connect to the field access point. 

 Four Ethernet ports: teams can now tether to the cRIO through the DAP-1522 using a standard Ethernet cable.  

Using this feature, teams will no longer have to unplug the wireless bridge in order to tether to the cRIO. Other 

devices, such as the camera, can also be connected to the Ethernet ports. 

 

Note: Do not use “Auto” mode. This will cause long delays when connecting. 
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Hardware Overview 

Front: 

 

 

 

Back: 

 

 

  

Mode selection switch 

Reset button 

Ethernet Ports (4) 

Traffic indicator lights (4) 

Power Light 

(blue) 

Bridge Light 

(orange) 

Access Point 

Light (blue) 
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Connecting to the DAP-1522 via Wi-Fi 

When connecting a computer to the DAP-1522 via Wi-Fi, ensure the computer’s network settings match the following: 

 IP address = 10.xx.yy.zz 

o xxyy is the team number (do not enter leading zeros). 

o zz is any number greater than 10 and less than 255. 

o Examples (team number follow by IP address) 

 19 = 10.0.19.51 

 109 = 10.1.9.51 

 190 = 10.1.90.51 

 1109 = 10.11.9.51 

 1190 = 10.11.90.51 

 1900 = 10.19.0.51 

 Subnet Mask = 255.0.0.0 
Also, make sure that Internet Version Protocol Version 6 (TCP/IPv6) is unchecked. 

Resetting a wireless bridge to default settings 

1. Plug in the power and Ethernet connections 

2. Wait for the either the orange Bridge light or blue Access Point light to begin flashing 

3. Hold the reset button (on the back of the unit) for 10 seconds then release 

4. Wait for the light to stop flashing (this signals the wireless bridge is starting to reset) 

5. Wait for the light to resume flashing, your wireless bridge is now reset 
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Configuring a Wireless bridge for Team Use 
1. Switch your D-Link unit to AP mode using the switch on the back 

2. Ensure your laptop is set to the proper IP address (192.168.0.51). 

3. Connect the wireless bridge to your computer using an Ethernet cable 

4. Start Internet Explorer* and type in your wireless bridge IP address (192.168.0.50) 

a. Username = admin 

b. Password = blank 

5. Click on Manual Wireless Network Setup 

 

*= other internet browsers such as Mozilla Firefox and Google Chrome do not always display the configuration web 

pages properly. 

6. The wireless bridge can be used with or without security in access point mode.  Change the Wireless settings to 

match one of the following setups: 

a. No security 
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*=2.4GHz is recommended in most cases.  If a team’s home facility has a significant amount of 2.4GHz wireless traffic/ 

interference, the team may want to select 5GHz.  If selecting 5GHz, please note that any computer that teams intend to 

connect to the DAP-1522 must support 5GHz wireless communications.  The CTL classmate computers provided in the 

Kit of Parts only support 2.4GHz wireless communications.  

Change the Wireless Network 

Name to your team number 

Disable Wi-Fi 

Protected Setup 

Disable Wireless 

Security 

2.4GHz recommended* 



© FIRST 2012 FRC Getting Started with the 2012 FRC Control System Page 34 of 46 
 

b. With security 

 

*= When using security, any computer connecting to the DAP-1522 via Wi-Fi will need this passphrase to gain access to 

the network. 

7. Save your settings 

8. Click on the Network Settings tab on the left side of the page 

9. Change the Network Settings as follows:  

Change the Wireless Network 

Name to your team number 

Change the Security 

Mode to WPA-Personal 

Change the WPA mode 

to WPA2 only 

Change the Cipher Type 

to AES 

Disable Wi-Fi 

Protected Setup 

Change the Passphrase to 

your WPA key* 

2.4GHz recommended (see 

note on previous page) 
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10. Save your settings 

  

Set the IP address to 10.xx.yy.1 

where xxyy is your team number 

Set the Subnet Mask to 255.0.0.0 

Set the Default Gateway to 

10.xx.yy.4 
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Configuring a Wireless bridge for Competition 

 

NOTE: At official FRC events, you must use the FRC Wireless Bridge Kiosk at or near the Inspection table to configure 
your wireless bridge.  These instructions are provided for reference purposes. 

 

1. Set your computer IP address to 192.168.0.51 

2. Switch your D-Link unit to Bridge mode using the switch on the back (the wireless bridge should always be in bridge 

mode at competition) 

3. Reset your wireless bridge 

4. Connect the wireless bridge to your computer using an Ethernet cable 

5. Start Internet Explorer and type in an address of 192.168.0.50 

a. Username = admin 

b. Password = blank 

6. Click on the Setup tab on the top menu bar 

7. Click on the Wireless tab on the left side of the page 
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8. Change the Wireless settings as follows: 

 

*= WPA keys are generated by the Field Management System at FRC events. 

9. Save your settings 

  

Change the Wireless Network 

Name to your team number 

Change the Security 

Mode to WPA-Personal 

Change the WPA mode 

to WPA2 only 

Change the Cipher Type 

to AES 

Disable Wi-Fi 

Protected Setup 

Change the Passphrase to 

your WPA key* 

Disable Wireless 

MAC Cloning 
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10. Click on the Network Settings tab on the left side of the page 

11. Change the Network Settings as follows:  

 
12. Save your settings 

  

Set the IP address to 10.xx.yy.1 

where xxyy is your team number 

Set the Subnet Mask to 255.0.0.0 

Set the Default Gateway to 

10.xx.yy.4 
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How to Configure Your I/O Module 
Now that you’ve confirmed that your basic Driver Station hardware and software is functional, add the I/O layer. Before 

using your Cypress FirstTouch I/O module, you must first program firmware into the USB chip on the board. The steps 

below will walk you through the process. Remember that you only need to do this step once per board. Make sure that 

you have the most recent version of the Driver Station software before proceeding. 

1) Log into the Developer account. 

2) Plug the USB cable provided in the FirstTouch starter kit into the I/O module and the Classmate. 

3) Allow the computer time to find and connect to the new hardware. 

4) Next, open the Cypress PSoC Programmer. If you are using LabVIEW on the same computer, you can find the 

PSoC Programmer in the Utilities tab of the Getting Started Window. Otherwise, click on Start > All Programs > 

Cypress > PSoC Programmer. If you get an Update Reminder, cancel it. Updating the PSoC Programmer will make 

the Driver Station unable to see the First Touch module 

 

5) In the top left of the tool bar, you’ll see a blue folder icon. Click the folder, browse to Shared or Public 

Documents/FRC, and select the FRC_IO.v3.hex or FRC_IO.v3.2010.hex (or latest version) file. You must select the 

correct firmware for the version of the module that you have. The location on the Classmate is 

Computer»Windows (C:) »Users»Public»Documents»FRC. If you are a rookie, you have a 2012 module. If you are 

a veteran teams and got your First Touch module in the 2010 or 2011 kit, use that firmware. Selecting the wrong 

firmware image will result in an error message and will not damage your First Touch module. 
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6) Directly below the tool bar, on the left, there is a Port Selection window with the device listed in it. Select the 

FirstTouch device. 

 

7) Click the program button on the tool bar, and wait for the programming operation to complete. You will see 

Programming Succeeded in the Results window. 
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8) Unplug and replug the USB cable and your I/O module will be ready to use. You can check to make sure the 

process was successful by opening the Driver Station software and confirming that the device is being 

recognized. With the I/O module plugged in, your I/O tab will indicate that the Hardware I/O is selected. 

Without the I/O module plugged in, it will default to the Virtual I/O. 

 

Troubleshooting: 

 If you are unable to find the firmware file, make sure that you have installed the Driver Station update. 

 If the PSoC Programmer errors with “The hex file does not match with the acquired device, please check the 

device”, make sure you selected the correct firmware file for the version of the First Touch module you are 

using. 

 If the Driver Station is unable to detect the First Touch I/O module… 
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o Check the version of the PSoC Programmer that you have installed 

 You should have version 3.12.0.827 if you look in Help >> About in PSoC Programmer 

o Check for the module in Device Manager under Universal Serial Bus controllers 

o If the device is listed as “FTK3 (unconfigured)” (USB PID=F119), the CyMiniProg3Service may not be 

running 

 Check for the service in Control Panel >> Administrative Tools >> Services 

 Check if it is started.  If not, start it and configure it to start automatically. 

o If the device is listed as “FTK3 (version)” (USB PID=F11A), and version does not equal 3.4.1.20, you may 

have installed a newer version of the PSoC Programmer 

 Uninstall the Driver Station Update and the PSoC Programmer update in Control Panel >> Add / 

Remove Programs 

 Reinstall the Driver Station Update 

o If the device is listed as “FTK3 (3.4.1.20)” 

 Make sure that the bootstrap firmware that is installed matches what the Driver Station needs. 

The file Program Files\Cypress\Programmer\3.12\Service\ftk_3_simfw.hex should be 29,663 

bytes. 

 Make sure that C:\Windows\system32\nicyapi.dll is installed and is version 1.0.0.49154 

o The Driver Station still won’t see the First Touch I/O Module 

 Try restarting the Driver Station after you’ve gotten everything else correct and the device is 

plugged in. 

For further help, look for a similar problem on the Cypress forums at http://www.cypress.com/?app=forum (be sure to 

select the “FIRST Robotics Competition” forum).  

http://www.cypress.com/?app=forum
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How to Configure your Kinect 
The steps below will walk you through setting up your Classmate PC to work with the Microsoft Kinect, for more details 

or to use the Kinect with another PC see the document at http://www.usfirst.org/frc/kinect.  

1. Go to http://kinectforwindows.org/download/ 

2. Select  the “32-bit download”  

3. Double click the downloaded file to begin the installation.  

a. Click Next to proceed with the install 

b. Click Next to proceed past the warning 

c. Check the box to accept the license agreement, and then click Next. 

d. If you wish to install the SDK to a specific location, choose it now using Change, otherwise click Next to 

install to the default location. 

e. Click Install to start the installation. 

f. When the installer completes, click Finish to exit the installer. 

4. Download the FRC Kinect Server from http://www.usfirst.org/frc/kinect.  

5. Extract the Zip file of the installer. Locate the Setup.msi file in the extracted folder and double click to begin the 
install.  

a. Click Next to proceed with the install  
b. Click Install to start the installation  
c. When the installer completes, click Finish to exit.  
d. The Kinect Server and Kinect Server source code are now installed in C:\Program Files\FRC Kinect Server 

 

Safety Note: It is highly recommended you secure a sizeable area 

around the robot and have someone prepared to disable the robot 

while you are getting used to controlling a robot using the Kinect. 

Alternatively, put your robot up on blocks so it is unable to move. 

Until you have some experience using the device it is very possible your robot 

may move in ways you do not expect. 

 

How to Use the default FIRST Kinect code 
1. Code examples are provided for each language which can control a 2-motor robot with Tank drive using the 

gestures provided by the Kinect Server. Reference ““How to Build and Load Programming in LabVIEW, C/C++, 

and Java” for information on how to open this project in your language. In LabVIEW select Robot Framework 

with Game Code. In Java and C++ look for KinectStickExample. The gestures have been mapped based on tank 

drive of a typical FRC drive base, and the buttons are activated by actions using your head and legs, for details 

on the Gestures see the next section. 

a. These joysticks behave like a typical joystick in many ways. The axis values range from -1 to 1 just like a 

standard joystick and the buttons are all active only when “pressed” using the appropriate gesture just 

like a typical joystick. 

http://www.usfirst.org/frc/kinect
http://kinectforwindows.org/download/
http://www.usfirst.org/frc/kinect


© FIRST 2012 FRC Getting Started with the 2012 FRC Control System Page 44 of 46 
 

b. It may be helpful to scale the joystick values to a fraction of max power when learning to use the Kinect. 

20%-25% may be a good value to start with. 

2. Load the new code onto your robot, again referencing the “How to Build and Load Programming in LabVIEW, 

C/C++, and Java” document if necessary. 

3. Plug your Kinect into your Driver Station laptop. 

4. Launch the Driver Station application and connect to your robot as you normally would.  

a. At this point, on the Diagnostics tab of the Driver Station, the Kinect light should be green and the text 

below should say 01.07.12.00 

 

5. Before enabling your robot make sure there is only a single player in the Kinect field-of-view and that they are 

either in a “disabled” position or have their arms out in the neutral axis position. Enabling the robot while the 

operator has their hands at their sides will cause the robot to move in an unexpected and potentially unsafe 

manner. 

a. The Driver Station has an indicator to help you identify how many people are presently recognized by 

the Kinect. This indicator is located on the Operation tab between the Elapsed time and the PC Battery. 

You should not enable a robot using Kinect code if this indicator shows more than 1 person in the field 

of view. If two skeletons are in frame, the closest one will be chosen; if more than two people are in 

frame an arbitrary skeleton is chosen. 

 

6. You should now be able to control your robot using the pre-programmed gestures. It is highly recommended 

you secure the area around the robot and have someone prepared to disable the robot while you are getting 

used to controlling the robot using the Kinect.  

7. The default Dashboard has a Kinect tab located above the camera image. Selecting this tab will show you a 

display of the skeleton currently seen by the Kinect as well as some joystick diagnostics that may be helpful 

when learning to drive using the Kinect device. 
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Pre-Programmed Gestures 
The wrist/shoulder skeletal data is processed to determine their relative angles for the KinectStick Y data.  The resulting 

angle information is formatted into the Y data field with a range of +1 to -1.  The KinectStick data consists of two Y 

joystick values (KinectStick1-Y and KinectStick2-Y). The diagram below illustrates the mapping of the wrist/shoulder 

skeletal data into standard joystick format: 

 

 

90

-90

0

RIGHT

Right KinectStick2 Y values
Map to Wrist/Shoulder Angle

Left KinectStick1 Y values
Map to Wrist/Shoulder Angle

Y= 1.00

Y= -1.00

Y= 0.00

Y= 0.50

Y=- 0.50

Fig 1 Human Player facing Kinect Y joystick value / angle interpretation
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Y = -1.00 has been placed at the top with the assumption that up naturally maps to forward and on a joystick, moving a 

joystick away from you moves Y towards -1.00. 

For Kinect joystick control to be enabled, both arms must be in the same XY plane (see figure 2).  In addition, both arms 

must be within the valid control range (defined as -90 to +110 degrees). If either arm is moved out of plane or out of the 

valid range, all axes and buttons will return 0/False.  This means the safest way to stop controlling the robot (other 

than disable or e-stop) is to bring both arms forward and cross them in front of your chest.  
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Fig 2 Wrist/hand to Elbow angle definition of Zero 
 

 

Given that the two arms are used for the two tank drive axes, the remaining body parts potentially available for use as 

buttons are the head and legs. The following buttons are currently implemented: 

1) Head to the Right 

2) Head to the Left 

3) Right leg out to the right 

4) Left Leg out to the left 

5) Right Leg Forward 

6) Right Leg Back 

7) Left Leg Forward 

8) Left Leg Back 

9) Kinect control “enable” signal. True if both arms are in-plane and in-range.  

Teams should note that the head buttons may trigger accidentally and/or may be difficult to trigger purposefully if one 

or both arms are near vertical. 

The button values are set the same for both KinectStick1 and KinectStick2.  
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